Abstract

Text processing with \LaTeX offers several advantages over word processing. However, it is often hard for beginners to figure out how to perform common tasks and obtain certain features. This manual attempts to ease the transition by drawing comparisons between word processing and \LaTeX typesetting. The main word processor capabilities are listed, along with their equivalent \LaTeX commands. Lots of examples are provided.
4 The Insert Menu

4.1 Insert/Breaks ................................................................. 9
4.2 Insert/Enumerated List .................................................. 10
4.3 Insert/Special Character ............................................. 11
  4.3.1 The $\in$ Sign ......................................................... 13
4.4 Insert/Formula ............................................................. 13
4.5 Insert/Footnote ............................................................ 13
  4.5.1 Footnotes at End of Document .................................. 14
4.6 Insert/Indices ............................................................... 14
4.7 Insert/Vertical and Horizontal Space ............................... 15
4.8 Insert/Tabs ................................................................. 15
4.9 Insert/Cross Reference .............................................. 15
4.10 Insert/Margin Notes .................................................... 16
4.11 Insert/Frame .............................................................. 16
  4.12 Insert/Figure ............................................................. 16
    4.12.1 Wrapping Floats ............................................... 18
4.13 Insert/Shapes ............................................................ 19
4.14 Insert/Line ............................................................... 20
4.15 Insert/Hyperlink ...................................................... 20
4.16 Insert/Comment ........................................................ 21

5 The Format Menu

5.1 Format/Line Spacing ................................................... 21
5.2 Format/Character ........................................................ 23
  5.2.1 Underline styles ................................................... 23
  5.2.2 Format/Character Size .......................................... 23
  5.2.3 Format/Character Font ......................................... 24
  5.2.4 Format/Character Colour ....................................... 25
5.3 Format/Paragraph ........................................................ 26
  5.3.1 Format/Paragraph Horizontal Alignment ...................... 26
  5.3.2 Format/Paragraph Vertical Alignment ......................... 26
  5.3.3 Format/Paragraph Margins ..................................... 28
  5.3.4 Format/Paragraph Indentation ................................ 28
5.4 Format/Paragraph Border and Shade ................................ 28
5.5 Format/Colour ............................................................ 30
5.6 Format/Columns .......................................................... 30

6 The Table Menu

6.1 Line Spacing ............................................................... 32
6.2 Aligning Numbers ....................................................... 33
6.3 Using slashbox ............................................................ 33
6.4 Importing Data in LATEX Tables ................................. 34

7 The Tools Menu

7.1 Tools/Mail Merges ........................................................ 35
1 Introduction

First of all, let me state that this is not a \LaTeX\ primer! If you’re reading this, I assume that you have at least a smattering of \LaTeX\ and its basic commands. In this document, I’ll explain why \LaTeX\ is a viable alternative to word processors. One may even think that \LaTeX\ is better than any word processor... and this is definitely true, especially if you write complex documents with lots of maths.

Nevertheless, word processors are the ‘killer app’ in modern office automation. They’re perceived to be easier than \LaTeX\ as they have a friendly WYSIWYG interface, and the average secretary will learn to use them in a relatively short time. The problem is, these beasts keep growing slow, bloated\footnote{once upon a time, I wrote my thesis on a 128k, Z80-based home computer. The word processor WordStar and my thesis fit on a single CP/M-bootable 720K floppy, with lots of room to spare!}, buggy, expensive, virus ridden, and incompatible with each other.
\LaTeXX might be a good alternative. It actually is, but if you try to write casual, unstructured documents, \LaTeXX will rightly stand in the way. You could resort to plain \TeX, but you would lose many facilities that \LaTeXX provides.

To sum up, sometimes you may want to use word processor-like features—but using \LaTeXX. It would be nice to know how to obtain some effects with \LaTeXX when you know how to get them with your once-favourite :-) word processor.

That’s why I wrote this quick reference. As I said, it assumes that you already have a basic understanding of \LaTeXX; if not, I suggest that you go to http://www.ctan.org/starter.html and download ‘The (Not So) Short Introduction to \LaTeXXe’ (and possibly ‘A Gentle Introduction to \TeX’).

In the following sections, we shall navigate through the menus and menu items of an imaginary word processor, finding out the corresponding \LaTeXX way of doing the same work. If you’re a \LaTeXX purist and this approach makes you sick… don’t hurt yourself, please stop here.

## 1.1 Preliminaries

Many word processor features are implemented by the editor; others by standard \LaTeXX commands; others still are obtained using packages. These are sets of macros that extend \LaTeXX providing new commands and environments. There are lots of packages around: the only problem is knowing where they are, what they do, and how to install them. More about packages in Section 1.1.2.

Packages and other \TeX-related material are available at many sites that constitute the CTAN, the Comprehensive TeX Archive Network. I already mentioned http://www.ctan.org; this site has a comprehensive list of mirrors. From now on, CTAN: means ‘your favourite CTAN mirror here, starting from the \TeX directory’. For instance, you can get \LaTeXX for your platform from CTAN://systems (e.g. http://www.tex.ac.uk/tex-archive/systems/).

Another obvious question is this: \LaTeXX will typeset the text for me, but what should I use to write it? The answer is: a good editor—a \LaTeXX-aware one, if possible. There exist editors dedicated to writing \LaTeXX source, and some are WYSIWYG or nearly so.

Although any editor capable of saving plain text will do (even Windows’ notepad), most \TeXnicians will recommend that you use one of the following:

- GNU Emacs (http://www.gnu.org/software/emacs/emacs.html) or Xemacs (http://www.xemacs.org) with AUC \TeX, CTAN://support/auctex/;
- \texttt{vi} or one of its clones, Vim (http://www.vim.org) being the most popular;
- my personal choice is Jed (http://www.jedsoft.org/jed/), a light Emacs clone that also supports emulation of other editors. I wrote a \LaTeXX mode for Jed, available from CTAN://support/jed;
- Kile (http://kile.sourceforge.net), a very nice and complete \LaTeXX shell for the KDE;
- Texmaker (http://perso.club-internet.fr/pascal.brachet/texmaker/index.html) is very similar to Kile, but doesn’t require KDE;
1 INTRODUCTION

1.1 Preliminaries

- **LyX** ([http://www.lyx.org](http://www.lyx.org)), a nearly-WYSIWYG text processor, less advanced as an editor but undoubtedly easier for beginners;

- **GNU TeXmacs** ([http://www.texmacs.org](http://www.texmacs.org)), an impressive WYSIWYG \LaTeX word processor for UNIX;

- **WinEdt** ([http://www.winedt.com](http://www.winedt.com)), probably the most popular \LaTeX shell for Windows. Unlike all of the free software above, it’s shareware;

- a comprehensive list of \LaTeX shells for Windows can be found at [http://home.arcor.de/itsfd/texwin.htm](http://home.arcor.de/itsfd/texwin.htm). I suggest that you have a look at TeXnicCenter and WinShell;

- finally, information about \LaTeX on the Mac can be found at [http://www.esm.psu.edu/mac-tex/](http://www.esm.psu.edu/mac-tex/).

These editors boast syntax highlighting and many other helpful features that help write \LaTeX source code.

1.1.1 Editor-Supported Features

\LaTeX is just a formatter: things like cut and paste, search and replace etc. are delegated to the editor. Table 1 summarises the main commands of popular editors for geeks: GNU *emacs* and *vim* with their native key bindings, and *jed* configured for Borland IDE key bindings.

1.1.2 Adding Packages

The following applies to teTeX, which ships with most GNU/Linux distributions. Directions for MiKTeX below.

1. get the package (typically as a gzip-compressed tar archive) from your favourite CTAN mirror;

2. find out the location of \LaTeX packages; most likely, $TEXMF/tex/latex;

3. as root, unpack the package under that directory;

4. If no .sty file exists, run the command `latex newstyle.ins` or `latex newstyle.dtx` to create it;

5. run the command `texhash` so that teTeX recognises the new package.

The exact location of $TEXMF$ depends on the system; in most GNU/Linux distributions, it’s `/usr/share/texmf`.

If you don’t have root privileges, you can install packages in a subdirectory of your $HOME$: say, `$HOME/texmf`. All you have to do is put the .sty files there, and add this line in your $HOME/.bash_profile:

```
export TEXINPUTS=""/texmf:"
```
<table>
<thead>
<tr>
<th>Action</th>
<th>Emacs</th>
<th>Vim</th>
<th>Jed</th>
</tr>
</thead>
<tbody>
<tr>
<td>command mode</td>
<td>Alt-X</td>
<td>ESC</td>
<td>Alt-X</td>
</tr>
<tr>
<td>insert mode</td>
<td>n/a</td>
<td>i a o 0</td>
<td>n/a</td>
</tr>
<tr>
<td>line editor mode</td>
<td>n/a</td>
<td>:</td>
<td>n/a</td>
</tr>
<tr>
<td>file operations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>open file</td>
<td>Ctrl-X Ctrl-F</td>
<td>:e</td>
<td>Ctrl-KE</td>
</tr>
<tr>
<td>insert file</td>
<td>Ctrl-Xi</td>
<td>:r</td>
<td>Ctrl-KR</td>
</tr>
<tr>
<td>save file</td>
<td>Ctrl-X Ctrl-S</td>
<td>:w</td>
<td>Ctrl-KD</td>
</tr>
<tr>
<td>save as</td>
<td>Ctrl-X Ctrl-W name</td>
<td>:w name</td>
<td>Ctrl-KS</td>
</tr>
<tr>
<td>close file</td>
<td>Ctrl-XK</td>
<td>:q</td>
<td>Ctrl-KQ</td>
</tr>
<tr>
<td>change buffer</td>
<td>Ctrl-XB</td>
<td>bN</td>
<td>Ctrl-KN</td>
</tr>
<tr>
<td>undo</td>
<td>Ctrl-XU</td>
<td>u</td>
<td>Ctrl-U</td>
</tr>
<tr>
<td>redo</td>
<td>Ctrl-~</td>
<td>Ctrl-R</td>
<td>Ctrl-G Ctrl-U</td>
</tr>
<tr>
<td>exit</td>
<td>Ctrl-X Ctrl-C</td>
<td>:qa!</td>
<td>Ctrl-KX</td>
</tr>
<tr>
<td>moving around</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>word left</td>
<td>Alt-B</td>
<td>b</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>word right</td>
<td>Alt-F</td>
<td>w</td>
<td>Ctrl-F</td>
</tr>
<tr>
<td>start of line</td>
<td>Ctrl-A</td>
<td>0</td>
<td>Ctrl-QS</td>
</tr>
<tr>
<td>end of line</td>
<td>Ctrl-E</td>
<td>$</td>
<td>Ctrl-QD</td>
</tr>
<tr>
<td>page up</td>
<td>Alt-V</td>
<td>Ctrl-U</td>
<td>Ctrl-R</td>
</tr>
<tr>
<td>page down</td>
<td>Ctrl-V</td>
<td>Ctrl-D</td>
<td>Ctrl-C</td>
</tr>
<tr>
<td>start of buffer</td>
<td>Alt-&lt;</td>
<td>1G</td>
<td>Ctrl-QR</td>
</tr>
<tr>
<td>end of buffer</td>
<td>Alt-&gt;</td>
<td>G</td>
<td>Ctrl-QC</td>
</tr>
<tr>
<td>line n.</td>
<td>Alt-G n.</td>
<td>n.G</td>
<td>Ctrl-QI</td>
</tr>
<tr>
<td>deleting</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>character left</td>
<td>Ctrl-H</td>
<td>X</td>
<td>BS</td>
</tr>
<tr>
<td>character right</td>
<td>Ctrl-D</td>
<td>x</td>
<td>Alt-G</td>
</tr>
<tr>
<td>word left</td>
<td>Alt-DEL</td>
<td>db</td>
<td>Alt-BS</td>
</tr>
<tr>
<td>word right</td>
<td>Alt-D</td>
<td>dw</td>
<td>Ctrl-T</td>
</tr>
<tr>
<td>end of line</td>
<td>Ctrl-K</td>
<td>d$</td>
<td>Ctrl-QY</td>
</tr>
<tr>
<td>line</td>
<td>Ctrl-A Ctrl-K</td>
<td>dd</td>
<td>Ctrl-Y</td>
</tr>
<tr>
<td>search &amp; replace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>search</td>
<td>Ctrl-S text</td>
<td>/text</td>
<td>Ctrl-QS</td>
</tr>
<tr>
<td>replace</td>
<td>Alt-%</td>
<td>:s/old/new/g</td>
<td>Ctrl-QA</td>
</tr>
<tr>
<td>blocks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>start selection</td>
<td>Ctrl-SPACE</td>
<td>v</td>
<td>Ctrl-KB</td>
</tr>
<tr>
<td>cut</td>
<td>Ctrl-W</td>
<td>D</td>
<td>Ctrl-KY</td>
</tr>
<tr>
<td>copy</td>
<td>Alt-W</td>
<td>Y</td>
<td>Ctrl-KH</td>
</tr>
<tr>
<td>paste</td>
<td>Ctrl-Y</td>
<td>P</td>
<td>Ctrl-KC</td>
</tr>
</tbody>
</table>

Table 1: Useful key bindings for Emacs, Vim, and Jed in IDE mode.
To add a package to MiKTeX, create the directory `\latex\newpackage` under `C:\localtexmf\tex` and put the relevant files in there. Proceed as above, then run MiKTeX Options and click on the ‘Refresh now’ button. Alternatively, issue the command `initexmf -u`. That’s it!

1.2 The Golden Rules

Before we start, please keep this in mind:

1. get used to structuring your documents: think in terms of parts, chapters, sections, and so on. This holds even if you are not writing a scientific paper.

2. \LaTeX{} explicitly discourages the user from messing about with formatting parameters. Don’t worry too much about the looks of what you’re writing, concentrate on the contents.

Convince yourself, apply the rules, and your printed material will magically look professional! Again, let me recommend that you study a real \LaTeX{} primer.

These rules apply to most documents. However, if the stuff you are going to write is intrinsically unstructured (circulars, notices, etc.), then you asked for that: go ahead and read the rest of this guide.

2 The File Menu

Obviously, some entries of this menu have nothing to do with \LaTeX{}: File/Open, File/Save, File/Close depend on the editor.

2.1 File/New

This is the \LaTeX{} equivalent of a blank page:

\begin{verbatim}
defocumentclass{article} 
defbegin{document} % This is a comment. Write your stuff here. 
defend{document}
\end{verbatim}

As documents written in \LaTeX{} are inherently structured, this is a more realistic example:

\begin{verbatim}
defocumentclass[a4paper,12pt]{article} 
defbegin{document} 
deftitle{My Document} 
defauthor{John Smith} 
defdate{London, \today} 
defmaketitle 
defbegin{abstract} % This is a very short article. 
\end{abstract}
\end{document}
\end{verbatim}
\section{First Section}
\label{sec:start}
This is the text of the section. See \cite{Gonzato} for details.
\section{End}
\label{sec:end}
This is the end of the document. Please go to Section \ref{sec:start} to read it again.
\begin{thebibliography}{99}
\bibitem{Gonzato} Gonzato G. \textit{\LaTeX{} for Word Processor Users}. CTAN, 2001.
\end{thebibliography}
\end{document}

More document templates are listed in Appendix A.

2.2 \textbf{File/Save As...}

The following tools are handy if you want to convert \LaTeX{} to other formats:

- \texttt{latex2html}: \url{http://saftsack.fs.uni-bayreuth.de/~latex2ht/}, CTAN://support/latex2html
- \texttt{latex2rtf}: CTAN://support/latex2rtf

See also Section 2.7 for details on PDF creation.

2.3 \textbf{File/Save As Template}

Saving a \LaTeX{} ‘template’ would mean, as I see it, create a new \LaTeX{} package. This is complex matter that goes beyond the scopes of this guide.

2.4 \textbf{File/Import}

These tools convert from other formats to \LaTeX{}:

- \texttt{rtf2latex}: CTAN://support/rtf2latex
- \texttt{html2latex}: CTAN://support/html2latex
- \texttt{wvware} is a set of tools that convert from MS Word to several formats including \LaTeX{}: \url{http://wvware.sourceforge.net}
- the free word processor Abiword, \url{http://www.abisource.com}, imports MS Word and can export \LaTeX{}. 


- txt2tex: CTAN://support/txt2tex does a fairly good job at converting plain text files into \LaTeX.

Other *\LaTeX* converters are available at the same address.

### 2.5 File/Page Setup

The normal method for setting paper size, orientation, and margins, is to use parameters in `\documentclass`. Paper size can be `a4paper`, `a5paper`, `b5paper`, `letterpaper`, `legalpaper`, `executivepaper`; orientation is `portrait` by default, or optionally `landscape`. For example,

```
\documentclass[a5paper,landscape,12pt]{article}
```

Document-wide margins are set with these commands:

```
\setlength{\leftmargin}{2cm}
\setlength{\rightmargin}{2cm}
\setlength{\oddsidemargin}{2cm}
\setlength{\evensidemargin}{2cm}
\setlength{\topmargin}{-1cm}
\setlength{\textwidth}{18cm}
\setlength{\textheight}{25cm}
```

The `geometry` package allows for complete control of parameters such as paper size, margins width, and so on. `geometry` has far too many options to list them all, and you’re invited to read its documentation. A fairly complete example of its usage is shown below. In this example, some parameters are not compatible with each other, and are there for purpose of argument only.

```
\geometry{paperwidth=25cm}
\geometry{paperheight=35cm}
\geometry{width=20cm} \% total width
\geometry{height=30cm} \% total heigth
\geometry{total={20cm,30cm}}
\geometry{textwidth=18cm} \% width - marginpar
\geometry{textheight=25cm} \% heigth - header - footer
\geometry{body={18cm,25cm}}
\geometry{left=3cm} \% left margin
\geometry{right=1.5cm} \% right margin
\geometry{mmargin={3cm,2cm}}
\geometry{top=2cm} \% top margin
\geometry{bottom=3cm} \% bottom margin
\geometry{vmargin={2cm,3cm}}
\geometry{marginparwidth=2cm}
\geometry{head=1cm} \% header space
```

Options can also be set this way:

```
\usepackage[left=3cm, right=2cm]{geometry}
```
2.5.1 Page Setup/Headers and Footers

The `fancyhdr` package provides the new command `\pagestyle{fancy}`. This will create a header reporting the current section (`chapter` in `book.cls`) and subsection, and a footer with the page number: pretty fancy indeed. Headers and footers can obviously be customised. They are made of three parts: a left-aligned part, a centre-aligned part, and a right-aligned part. To set those, use the commands like in this example:

\head{} % empty
\chead{Hello, world!}
\rhead{Page \thepage} % page number
\lfoot{}
\cfoot{\textbf{Hello!}}
\rfoot{}

2.6 File/Printer Setup

This is highly OS-dependent, and definitely outside of the scopes of \LaTeX. Assuming that you’re using a UNIX-like system, these tips may come in handy:

- `lpr -P printername` prints to the specified printer;
- `lpr -# 10` prints 10 copies;
- `lpr -r` removes the file after printing it

See below for more tips.

2.7 File/Print Preview

When the \LaTeX input file is ready, you have several options:

- convert it to `.dvi` (`latex file.tex`) and previewing it with `xdvi`, `yap` or other DVI previewer;
- convert the `.dvi` to POSTSCRIPT with `dvips`, then use some variant of `Ghostview`;
- producing an Acrobat `.pdf` file with `dvipdf` or directly with `pdflatex`.

In my opinion, producing an Acrobat `.pdf` file is the best option, as it makes for widest portability.

While `dvipdf` is just a script that converts the `.dvi` to `.ps` then to `.pdf`, using `pdflatex` is more interesting. In fact, some packages like `hyperref` and `url` make the resulting `.pdf` file browseable; see Section 4.15. However, using `pdflatex` you might experience problems with other packages. More details in Section 4.12.

2.8 File/Print

Simply use `lpr file.ps` from the command line, or via your previewer’s menu.
2.9 File/Versions

Although the version package provides basic facilities for versioning \LaTeX{} sources, it’s better to use external tools like RCS (Revision Control System) or CVS (Concurrent Version Control System), possibly integrated with the editor. For a quick introduction to CVS and RCS, please visit http://www.linuxdoc.org/HOWTO/CVS-RCS-HOWTO.html.

3 The Edit Menu

This menu has more to do with the editor than \LaTeX{} features. To begin with, refer to Table 1 that shows the key bindings for the entries Edit/Cut, Edit/Copy, Edit/Paste, Edit/Find, and Edit/Replace of some common editors.

The selection of text is not only performed for subsequent cut and paste, but also for applying styles to the selected text. The equivalent action in \LaTeX{} is to enclose the text either between \textbf{} or in an environment. For example, to apply the bold attribute to a portion of text you will use one of the following:

\begin{verbatim}
this is \textbf{bold text};
this is also
\{\bfseries bold text;\\
\begin{bfseries}
this is bold text, too!
\end{bfseries}
\end{verbatim}

3.1 Edit/Autotext

We call \textit{autotext} the feature that makes you type, say, ‘PS’ to have the word ‘PostScript’ automatically expanded. This is an editor feature, but there’s a rough \LaTeX{} equivalent:

\begin{verbatim}
\def\PS {\textsc{PostScript}}
\end{verbatim}

which will insert the equivalent of \textsc{PostScript} whenever you type \PS. Beware, case is important.

4 The Insert Menu

4.1 Insert/Breaks

- a non-breakable space is set with ~
- to force a line break, use \linebreak or \newline; see below for details
- to start a new paragraph use a blank line, or \ (possibly followed by an optional space, as in \[1cm]), or \par
- finally, for a page break use \newpage or \clearpage
Unlike \newline, \linebreak stretches the line to the margins:

```
| I am stretched!\linebreak |
| But I am not.\newline    |
| Ok, now you get it.     |
```

```
| I am stretched!         |
| But I am not.           |
| Ok, now you get it.     |
```

Finally, \clearpage differs from \newpage in that it prints all pending floats (figures and tables). Floats will be explained in Section 4.12.

### 4.2 Insert/Enumerated List

Bulleted and enumerated lists correspond to the \itemize and \enumerate environments. To customize the bullet in a list environment, you can specify it as an argument to \item:

```
\begin{itemize}
\item [*] with an asterisk;
\item [-] with a dash;
\item [.] with a dot.
\end{itemize}
```

```
* with an asterisk;
- with a dash;
. with a dot.
```

Another way is to redefine the style of the counters that refer to the digits in the first- to fourth-level lists\(^2\). There are several styles: \arabic for ‘normal’ numbers, \roman for lower-case roman numerals (e.g. viii is 8), \Roman for upper-case roman numerals, \alph and \Alph for lower- and upper-case letters, and \fnsymbol that I will not explain for now:

```
\begin{itemize}
\renewcommand{\labelitemi}{*}
\renewcommand{\labelitemii}{-}
\item first level, item 1
\item first level, item 2
\begin{itemize}
\item second level, item 1
\item second level, item 2
\end{itemize}
\item first level, item 3
\end{itemize}
```

```
* first level, item 1
* first level, item 2
  - second level, item 1
  - second level, item 2
* first level, item 3
```

\(^2\)These are \labelitemi, \labelitemii, \labelitemiii and \labelitemiv.
To use, say, roman numbers and uppercase letters in enumerated lists, do this:

\begin{enumerate}
  \renewcommand{\labelenumi}{\Alph{enumi}}
  \item first level, item 1
  \item first level, item 2
  \begin{enumerate}
    \item second level, item 1
    \item second level, item 2
  \end{enumerate}
  \item first level, item 3
\end{enumerate}

Alternatively, use the \texttt{enumerate} package. It redefines the \texttt{enumerate} environment with the ability to specify an optional argument. Any occurrence of one of the characters A a I i 1 will produce the value of the counter, using (respectively) \texttt{\Alph}, \texttt{\alph}, \texttt{\Roman}, \texttt{\roman}, or \texttt{\arabic}. To include some text, enclose it in braces:

\begin{enumerate}[(Example) I.]
  \item First example.\label{item:first}
  \item Second example.\label{item:second}
  \item Last example. Go to Item \ref{item:first}.
\end{enumerate}

\texttt{Example I. First example.}
\texttt{Example II. Second example.}
\texttt{Example III. Last example. Go to Item I.}

\section{Insert/Special Character}

First of all, let’s remind that some characters have a special meaning in \LaTeX{} and must be entered either by preceding them with \texttt{\textbackslash}, or using them in math mode, or even writing special commands: see Table \ref{tab:special-chars}.

There are packages that provide thousands of unusual characters and symbols. For instance, \texttt{pifont} provides the commands \texttt{\ding}, \texttt{\dingfill}, \texttt{\dingline}, and \texttt{\dinglist}. The first command produces the Dingbat character of the specified code. The other commands are equivalent to the \texttt{\fill}, \texttt{\line}, and \texttt{\list} commands and environment, but use the Dingbat code given as parameter:

\begin{verbatim}
\begin{dinglist}{43}
  \item one
  \item two
  \item three
\end{dinglist}
\end{verbatim}

\begin{itemize}
  \item one
  \item two
  \item three
\end{itemize}
<table>
<thead>
<tr>
<th>Character</th>
<th>\LaTeX{} Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>\textdollar{}</td>
</tr>
<tr>
<td>&amp;</td>
<td>&amp;</td>
</tr>
<tr>
<td>%</td>
<td>%</td>
</tr>
<tr>
<td>_</td>
<td>\textunderscore{}</td>
</tr>
<tr>
<td>{</td>
<td>{}</td>
</tr>
<tr>
<td>}</td>
<td>}</td>
</tr>
<tr>
<td>&lt;</td>
<td>\textless{}</td>
</tr>
<tr>
<td>&gt;</td>
<td>\textgreater{}</td>
</tr>
<tr>
<td>\textbackslash{}</td>
<td>\textbackslash{}</td>
</tr>
<tr>
<td>\textbar{}</td>
<td>\textbar{}</td>
</tr>
<tr>
<td>\textbullet{}</td>
<td>\textbullet{}</td>
</tr>
<tr>
<td>\textdaggerdbl{}</td>
<td>\textdaggerdbl{}</td>
</tr>
<tr>
<td>\textdagger{}</td>
<td>\textdagger{}</td>
</tr>
<tr>
<td>\textparagraph{}</td>
<td>\textparagraph{}</td>
</tr>
<tr>
<td>\textsection{}</td>
<td>\textsection{}</td>
</tr>
<tr>
<td>\textcopyright{}</td>
<td>\textcopyright{}</td>
</tr>
<tr>
<td>\textasciicircum{}</td>
<td>\textasciicircum{}</td>
</tr>
<tr>
<td>\textasciitilde{}</td>
<td>\textasciitilde{}</td>
</tr>
<tr>
<td>\textregistered{}</td>
<td>\textregistered{}</td>
</tr>
<tr>
<td>\texttrademark{}</td>
<td>\texttrademark{}</td>
</tr>
<tr>
<td>\textordfeminine{}</td>
<td>\textordfeminine{}</td>
</tr>
<tr>
<td>\textordmasculine{}</td>
<td>\textordmasculine{}</td>
</tr>
</tbody>
</table>

Table 2: How to obtain some special characters.
Another nice variant is this:

\begin{dingautolist}{172}
\item one
\item two
\item three
\end{dingautolist}

There are far too many symbols to mention them all in this guide. Rather, I’ll point you to ‘The Comprehensive \LaTeX Symbol List’ at CTAN://info/symbols/comprehensive.

### 4.3.1 The € Sign

The marvosym package provides several fine characters, among which the Euro sign €. You obtain it with \EUR.

### 4.4 Insert/Formula

\LaTeX is particularly strong at doing math. To insert math symbols in the main text, you must enclose them between $:

\begin{itemize}
\item I like math: $x^n + y^n \neq z^n \forall n \neq 2$
\end{itemize}

Fermat’s Last Theorem is defined as:

\begin{equation}
\label{eq:fermat}
x^n + y^n \neq z^n \forall n \neq 2
\end{equation}

Can you prove Eq.~\ref{eq:fermat}?

### 4.5 Insert/Footnote

The command \footnote[n]{footnote text} is all you need; the optional parameter [n] modifies the footnote number. To use a symbol or arbitrary text instead of a number, redefine the counter associated with \footnote:

\renewcommand{\thefootnote}{read me!}

This footnote\footnote{read me!} says it all.

Using this method, you can get footnote numbers in roman numerals, or replaced by nice symbols:
\renewcommand{\thefootnote}
{\Roman{footnote}}
This\footnote{The first.}
is the first footnote,
and this\footnote{The second.}
is the second.
\renewcommand{\thefootnote}
{\fnsymbol{footnote}}
The end.\footnote*{At last!}
Note the $\fnsymbol{footnote}$ thing. It uses 9 symbols associated with the values 1...9 of
the footnote counter: * † ‡ § ¶ ∥ ∗∗ †† ‡‡.
To make several references to the same footnote, don’t write its number explicitly. Rather, do
this:
This\footnote{the first.}
\newcounter{myfootnote}
\setcounter{myfootnote}
{\value{footnote}}
and that\footnote{the second.}
are footnotes: please read note
footnotemark
[\value{myfootnote}] again.
Warning: minipages use their own counters, mpfootnote and thempfootnote.

4.5.1 Footnotes at End of Document
The endnotes package lets you move all footnotes at the end of the document. You’ll have to
add this line to the preamble:
\let\footnote=\endnote
and these lines as the last thing in your document:
\newpage
\begingroup
\parindent 0pt
\parskip 2ex
\def\enotesize{\normalsize}
\theendnotes
\endgroup
Other commands are available, please read the endnotes.sty source.

4.6 Insert/Indices
Generating and inserting a table of contents, list of tables, and list of figures is a trivial task in
\LaTeX. All you have to do is insert these lines before the first \texttt{\section} or \texttt{\chapter} of your
document:
4.7 Insert/Vertical and Horizontal Space

This entry doesn’t actually exist in any word processor I am aware of. This is in fact a limitation that \LaTeX fills in a very elegant way.

Space filling is used to center text horizontally, vertically, or both; this is a difficult task to perform with any word processor, and requires a lot of trial and error. Use a combination of \null or ~ to set fixed marks, followed by \vfill and \hfill like in this example:

\begin{verbatim}
one \hfill two\\
\vfill
~ \hfill three \hfill ~\\
\vfill
four \hfill five
\null
\end{verbatim}

Normally, \LaTeX won’t let you insert blank spaces at your will. However, if you do want to make your document look messy, use ~ to make a non-breakable space.

Also, use the command \hspace like in this example:

This is a \hspace{2cm}
2-cm-wide hole.

4.8 Insert/Tabs

The tabbing environment provides a rough equivalent to the action of the TAB key. See this example:

\begin{verbatim}
\begin{tabbing}
% let’s set the tab positions
~ \hspace{1cm} \= ~ \hspace{2cm} \=
~ \hspace{3cm} \= \\
% discard text
Zero \> One \> Two \> Three \>
Zero \> One \> \> Three \+ \% go right
Zero \> Two \> Three \- \% go left
Zero \> One \> Two \>
\pushtabs \% save tab positions
new tab 1\ldots \new tab 2 \>
new \> tab \\
\poptabs \% restore tab positions
Zero \> One \> Two \>
\end{tabbing}
\end{verbatim}

Zero One Two Three
Zero One Two Three
Zero One Two Three
new tab 1... new tab 2
new tab
Zero One Two Three

See also the \tabular and \table environments.

4.9 Insert/Cross Reference

The commands \label, \ref, and \pageref are all you need to insert labels in the text and do cross referencing. The standard format of labels is the prefix:suffix form, where prefix is
one of the following: cha for chapters, eq for equations, fig for figures, sec for (sub)sections, and tab for tables.

References to a page (section, table, figure, etc.) number can be obtained using \label and \ref as in this example:

\label{par:example}
This paragraph appears in Section \ref{par:example} on page \pageref{par:example}.

Of course, you may use your own prefixes. For example, take this enumerated list:

\begin{enumerate}
  \item{first step: skip to \ref{item:end} \label{item:start}}
  \item{another step (unreferenced)}
  \item{end: go back to \ref{item:start} \label{item:end}}
\end{enumerate}

1. first step: skip to 3
2. another step (unreferenced)
3. end: go back to 1

4.10 Insert/Margin Notes

Very simple: use \marginpar{text}.

4.11 Insert/Frame

Let’s imagine you want to typeset a poster or a sign: you’ll need a way to put text and figures on fixed position on the page. Use the textpos package, as shown in the example listed in Figure 7 (see Appendix A).

A simpler approach is using minipages: literally, miniature pages. This text is included in a minipage environment. Actually, to be more precise, a boxedminipage, courtesy of the boxedminipage package. I used this declaration:

\begin{boxedminipage}[c]{0.6\linewidth}
... text ...
\end{boxedminipage}

4.12 Insert/Figure

(The reference guide for graphic inclusion in \TeX is ‘Using Imported Graphics in \TeX\textsuperscript{2e}, a.k.a. \texttt{epslatex.ps}.)

A ‘figure’ can be not only a picture, but also a portion of text, a table, etc. that you put in a figure environment. This is an example:

Please note that figures are not guaranteed to appear exactly where you write the code! In fact,
the main difference with word processors is that figures don’t have a fixed placement; they ‘float’ to the optimal position that \LaTeX finds for them. So, the text shouldn’t refer to a figure like ‘the figure below’ or ‘the figure above’; rather, use ‘see Figure\ref{fig:label}'.

Owing to this property, figures and tables are called "floats." If you do need to position a float exactly, use the \texttt{here} package that provides an optional placement argument \texttt{H}.

Given a picture in Encapsulated PostScript (.eps) format, you insert it in a \LaTeX source file using the \texttt{graphicx} package and commands like those shown in Figure 2.

When you typeset your document with \texttt{latex} then \texttt{dvips}, graphic inclusion only works with EPS files; \texttt{pdflatex} accepts JPG, PNG, and of course PDF files.

There are several packages that convert common graphic formats like .jpg, .gif, .png etc. to .eps; for example, ImageMagik (\texttt{http://www.imagemagik.org}) and The GIMP (\texttt{http://www.gimp.org}). However, these applications produce huge PostScript files.

Best results are obtained using applications that wrap the bitmap, turning it into a compact PostScript file. You’ll want to use \texttt{jpeg2ps} (\texttt{http://www.pdflib.com/jpeg2ps/index.html}) or \texttt{bmeps} (CTAN://support/bmeps). The former is often the best choice for wrapping .jpg files, but the latter handles more graphics formats.

\begin{figure}
\begin{center}
\fbox{\includegraphics[width=0.5\textwidth, angle=-90]{gnuplot.ps}}
\caption{A Gnuplot graph.}
\label{fig:gnuplot}
\end{center}
\end{figure}

\begin{figure}
\begin{center}
\caption{A smiley representing the author of this guide.}
\end{center}
\end{figure}

If you use PDFLaTeX, you must convert your pictures to .pdf with the command \texttt{epstopdf} and modify the source accordingly!
If you wish to make both .pdf and .ps from the same source file, include these commands:

```latex
\% define the variable \ifpdf
newif\ifpdf
\ifx\pdfoutput\undefined
  \pdffalse
\else
  \pdfoutput=1
  \pdfture
\fi
...
\% include the right options
\ifpdf
  \usepackage[pdftex]{graphicx}
  \pdffcompresslevel=9
\else
  \usepackage{graphicx}
\fi
...
\% include the right graphic file
\ifpdf
  \includegraphics{file.pdf}
\else
  \includegraphics{file.eps}
\fi
```

If you have more than 18 figures without text between them, you’ll get the ‘Too many unprocessed floats’ \LaTeX{} error. The quickest way to solve this problem is to put `\clearpage` after three or four figures.

### 4.12.1 Wrapping Floats

For a magazine-like layout, use the \texttt{wrapfig} package:

When you meet this guy, give him some money.

```latex
\begin{wrapfigure}[4]{l}[5pt]{2cm}
  \Huge
  \texttt{=8-)}
\end{wrapfigure}
```

The reason may not be apparent to you, but I can assure that your money will end up in good hands. I say again, if you meet this guy, give him some money: he knows how to use it properly. OK?
The parameters are the number of lines to be narrowed, the figure placement, the overhang, and
the figure width.
Another package to perform the same action is floatfit:

\begin{floatingtable}{
\small
\begin{tabular}{l}
\hline
\textbf{Floating table}\nText flows around.\n\hline
\end{tabular}}
\end{floatingtable}

4.13 Insert/Shapes

\LaTeX\ provides a picture environment within which you use commands like \texttt{\circle{..}}, \texttt{\oval{..}}
and so on. In my opinion, drawing pictures without a graphical environment is just too hard,
and picture has several limitations too. It’s much better to use the epic and eepic packages
(include them in that order), together with the drawing program Xfig (\url{http://www.xfig.org}).
It’s only available for UNIX.

Xfig looks ugly, but is very powerful. One of its greatest advantages is that it exports draw-
ings in several formats, among which is eepic macros. These, in turn, produce very compact
PostScript files. Another bonus is that text objects will be rendered by \LaTeX\ if their ‘special
flag’ field is set, letting you enter ordinary \LaTeX\ formulae and symbols in drawings.

So, let’s suppose you made a drawing called \texttt{small.fig}. Select File/Export… and choose ‘LaTeX
picture + eepic macros’ from the Language menu. You’ll obtain another file, \texttt{small.eepic}. To
include the drawing in a document:

\begin{quote}
This is a picture
\begin{verbatim}
\input{small.eepic}
\end{verbatim}
\end{quote}

Unfortunately, eepic doesn’t work with \texttt{pdflatex}. As an alternative, you should export the draw-
ing as ‘Combined PS/LaTeX (both parts)’. You’ll get two files, \texttt{small.pstex} and \texttt{small.pstex.tex}.
Rename the latter to \texttt{small.tex} and edit it to insert these lines at the top:

\begin{verbatim}
\documentclass{article}
\usepackage{graphicx}
\end{verbatim}
4 THE INSERT MENU

\pagestyle{empty}
\begin{document}

and this line at the bottom:

\end{document}

Compile it as usual, convert the .ps to .eps and include it as explained in \ref{sec:4.12}.

If you wish to do real magic, then check out pstricks: http://www.tug.org/applications/PSTricks/. It lets you make fine \TeX{} drawings in \LaTeX{}. Another wonderful program is ePiX (http://mathcs.holycross.edu/~ahwang/current/ePiX.html), specialised in producing scientific plots and figures for inclusion in \LaTeX{} documents.

4.14 Insert/Line

Draw lines of any length and thickness with \texttt{\rule{}}:

This is a page-wide rule:
\texttt{\rule{\linewidth}{1pt}}
but this one is shorter and thicker:
\texttt{\rule{2cm}{2mm}}

Another interesting ‘line’ is that made of dots (\texttt{\dotfill}), often used to relate things. This is how it’s done:

Total price \dotfill \EUR{}10

\begin{tabular}{l}
\texttt{\dotfill} \EUR{}10
\end{tabular}

4.15 Insert/Hyperlink

The \texttt{url} package lets you write URLs and have them hyphenated correctly. When used together with the package hyperref and \texttt{dvipdf} or \texttt{pdflatex}, \texttt{url} lets you make browseable .pdf documents! For instance, this document uses this declaration:

\usepackage[colorlinks, urlcolor=blue, filecolor=magenta]{hyperref}
\usepackage[url]

Let’s see an example:

The \texttt{\hypertarget{ctan}{CTAN}} main site is \url{http://www.ctan.org}, a.k.a
\href{http://www.ctan.org}{CTAN://}.

Listen to \href{run:midifile.mid}{this MIDI file}.

Click \hyperlink{ctan}{here} to go back to the top.
The \texttt{\hypertarget} and \texttt{\hyperlink} commands provide internal links, just like HTML; \texttt{\href} creates links to URLs or external files. Note the \texttt{run:} parameter: you can run external programs like multimedia players, office applications, whatever. As far as I know, this feature only works using Acrobat Reader.

On Linux and possibly other UNIX variants, you’ll have to instruct Acrobat what to run when an external file is referenced. Insert lines like the following in your \texttt{.mailcap} or \texttt{/etc/mailcap}:

\begin{verbatim}
audio/midi;/usr/bin/timidity %s
audio/*; xmms %s
video/*; xine -pfhq %s
\end{verbatim}

Please read \texttt{hyperref}’s documentation for further examples and possibilities.

\section*{4.16 Insert/Comment}

This is done inserting \% before each line, or by using the package \texttt{comment} that provides the environment of the same name.

\section*{5 The Format Menu}

In general, the main format properties of a document are set with parameters in \texttt{\documentclass}: default font size (10, 11, or 12pt), paper (\texttt{a4paper}, \texttt{a5paper}, \texttt{b5paper}, \texttt{letterpaper}, \texttt{legalpaper}, \texttt{executivepaper}), and orientation (\texttt{portrait}, \texttt{landscape}). For example,

\begin{verbatim}
\documentclass[a5paper,landscape,12pt]{article}
\end{verbatim}

Alternative font sizes can be specified as explained in Section 5.2.2.

\section*{5.1 Format/Line Spacing}

The package \texttt{setspace} provide the environments \texttt{singlespace}, \texttt{onehalfspace}, and \texttt{doublespace}. In addition, the environment/command \texttt{\spacing{amount}} will set the spacing to the specified amount:

\begin{verbatim}
\begin{spacing}{2.5}
These two lines \textbackslash \textbackslash
are crazily spaced!
\end{spacing}
\begin{spacing}{1}
Much better, these lines \textbackslash \textbackslash
have a pretty space.
\end{spacing}
\end{verbatim}

These two lines
are crazily spaced!

Much better, these lines
have a pretty space.
<table>
<thead>
<tr>
<th>Text attribute</th>
<th>Environment form</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textnormal</td>
<td>textnormal</td>
<td>main document font</td>
</tr>
<tr>
<td>\textit</td>
<td>itshape</td>
<td>italics</td>
</tr>
<tr>
<td>\textbf</td>
<td>bfseries</td>
<td>boldface</td>
</tr>
<tr>
<td>\textsc</td>
<td>scshape</td>
<td>SMALL CAPS</td>
</tr>
<tr>
<td>\texttt</td>
<td>ttfamily</td>
<td>typewriter</td>
</tr>
<tr>
<td>\textsuperscript</td>
<td>n/a</td>
<td>this is superscript</td>
</tr>
</tbody>
</table>

\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]
\[ x^n + y^n \neq z^n \forall n \neq 2 \]

Table 3: Font attributes.
5.2 Format/Character

Standard character properties are listed in Table 3, font sizes in Table 4.

Please note the difference between italics and emphasised text. For example, this portion of text is typeset in italics, and these words are emphasised in upright. As you can see, \texttt{emph} is a logical rather than typographic command.

Also, please note that underscript is normally used in math mode only. The trick to use it in normal text is:

\begin{verbatim}
this is \footnotesize{subscript}
\end{verbatim}

<table>
<thead>
<tr>
<th>Font size</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>tiny</td>
<td>sample text</td>
</tr>
<tr>
<td>scriptsize</td>
<td>sample text</td>
</tr>
<tr>
<td>footnotesize</td>
<td>sample text</td>
</tr>
<tr>
<td>small</td>
<td>sample text</td>
</tr>
<tr>
<td>normalsize</td>
<td>sample text</td>
</tr>
<tr>
<td>large</td>
<td>sample text</td>
</tr>
<tr>
<td>Large</td>
<td>sample text</td>
</tr>
<tr>
<td>LARGE</td>
<td>sample text</td>
</tr>
<tr>
<td>huge</td>
<td>sample text</td>
</tr>
<tr>
<td>Huge</td>
<td>sample text</td>
</tr>
</tbody>
</table>

Table 4: Font sizes

5.2.1 Underline styles

Normally, underline is not used. It’s just a relic of the old teletype era, and it doesn’t look really good. If you still want to use underline, the \texttt{ulem} package provides some fancy styles:

\begin{verbatim}
\uline{important}
\uuline{urgent}
\uwave{boat}
\sout{wrong}
\xout{removed}
\end{verbatim}

Beware: \texttt{ulem} redefines the \texttt{emph} command, which will be replaced by underline. To avoid this behaviour, use this declaration:

\begin{verbatim}
\usepackage[normalem]{ulem}
\end{verbatim}

5.2.2 Format/Character Size

If the standard font sizes aren’t enough for you, the package \texttt{extsizes} may be handy. It provides ‘extended’ versions of the standard document classes, with support for sizes 8–12, 14, 17, and 20 pt.
For example, let’s suppose you want to typeset an article using a 17 pt font. You’ll use this document preamble:

\documentclass[17pt]{extarticle}

Another way to get big fonts is to use the package \texttt{type1cm}, which provides commands like the following:

\fontsize{72pt}{72pt}\selectfont
No Smoking

(The example above is way too large to fit on this page…)

Parameters are font size and baseline. Yet another approach is this:

\resizebox{!}{1cm}{1-cm tall}

5.2.3 Format/Character Font

\LaTeX{} uses its own fonts, automatically generated when needed by the \texttt{METAFONT} subsystem. This ensures portability and yields very good results. However, many of us are accustomed to other fonts: Times, Helvetica, Sans Serif…

Fortunately, \LaTeX{} can use \texttt{POSTSCRIPT} fonts. Try using one of the following packages: \texttt{avant}, \texttt{avangar}, \texttt{bookman}, \texttt{chancery}, \texttt{charter}, \texttt{courier}, \texttt{helvet}, \texttt{helvetic}, \texttt{ncntrsbk}, \texttt{newcent}, \texttt{palatcm}, \texttt{palatino}, \texttt{pifont}, \texttt{times}, \texttt{utopia}, \texttt{zapfchan}. Insert \texttt{\usepackage{times}} and enjoy the results. The only caveat is that \LaTeX{} handles maths at its best only with Computer Modern fonts: using \texttt{POSTSCRIPT} fonts might render your formulas slightly less appealing.

The packages above set the font for the whole document. To use a \texttt{POSTSCRIPT} font for a region of text only, specify the font family as in the example below. Common font families are listed in Table 5.

\begin{itemize}
  \item \texttt{\sfdefault} (sans serif)
\end{itemize}

Yet another possibility is replacing a standard \LaTeX{} font with a \texttt{POSTSCRIPT} one: for example, you may want to use Avantgarde whenever Computer Modern Sans Serif would appear. These commands can be renewed as in the example below:

\begin{itemize}
  \item \texttt{\rmdefault} (roman)
  \item \texttt{\sfdefault} (sans serif)
\end{itemize}
<table>
<thead>
<tr>
<th>Family</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmr</td>
<td>Computer Modern Roman</td>
</tr>
<tr>
<td>cmss</td>
<td>Computer Modern Sans Serif</td>
</tr>
<tr>
<td>cmtt</td>
<td>Computer Modern Typewriter</td>
</tr>
<tr>
<td>pag</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>pbk</td>
<td>Bookman</td>
</tr>
<tr>
<td>phv</td>
<td>Helvetica</td>
</tr>
<tr>
<td>pnc</td>
<td>New Century Schoolbook</td>
</tr>
<tr>
<td>ppl</td>
<td>Palatino</td>
</tr>
<tr>
<td>ptm</td>
<td>Times</td>
</tr>
<tr>
<td>pcr</td>
<td>Courier</td>
</tr>
</tbody>
</table>

Table 5: Common font families.

- \textttdefault (typewriter)
- \bfdefault (boldface)
- \mddefault (medium)
- \itdefault (italics)
- \sldefault (slanted)
- \scdefault (small caps)
- \updefault (upright)

% Avantgarde replaces sans serif
\renewcommand{\sfdefault}{pag}

5.2.4 Format/Character Colour

You can colour words using the package color and appropriate commands. Predefined colours are black, white, red, green, blue, cyan, magenta, and yellow; you can also define your own.

\textcolor{red}{This is red.}\
\color{blue}
This text is blue!\
So is this. Let's change.\
\definecolor{mygreen}{rgb}{0.1,1,0.1}\
\color{mygreen}
This is my shade of green!\
\color{black}\
\colorbox{cyan}{A cyan box}\
\fcolorbox{blue}{green}{A green box in a blue frame}\

Moreover, the command \pagecolor lets you specify... guess what?
5.3 **Format/Paragraph**

Let’s remind what a paragraph is according to \LaTeX: a portion of text that either ends with \\
, or is followed by a blank line.

*Environments* are \LaTeX’s way of specifying properties like text alignment or font selection for a given portion of text. It’s like selecting text with the mouse, then choosing the property you wish from a menu or clicking on a button. Another way is to enclose the text between brackets. Environments have this general form:

\begin{environment}
...text goes here...
\end{environment}

For example, if you want to center a paragraph you’ll use the `center` environment:

\begin{center}
this text is centered
\end{center}

Standard environments are listed in Table 6. In the following sections, I’ll show you what to use and when.

5.3.1 **Format/Paragraph Horizontal Alignment**

By default, the text is justified. To get left–aligned, right–aligned or centered text, use the `flushleft`, `flushright` and `center` environments. The commands `\raggedright`, `\raggedleft`, and `\centering` are equivalent to their correspondent environments, but they do not start a new paragraph.

5.3.2 **Format/Paragraph Vertical Alignment**

The way paragraphs are separated is often puzzling to word processor users. *Empty lines and multiple spaces are treated like a single empty line or space.* The commands `\smallskip`, `\medskip`, and `\bigskip` provide some space between paragraphs.

If you need more space, use the command `\vskip{parameter}` as in this example:

These paragraphs will be separated by 1.3 cm:\
\vskip 1.3 cm
there is a 1.3 cm gap above me.

These paragraphs will be separated by 1.3 cm:
\vskip{parameter}
there is a 1.3 cm gap above me.

Note that `\vskip` only works between paragraphs. What if you wanted to start a page after an additional margin of, say, 1.5 cm? You’ll have to use `\null`, which sets a ‘mark’ in the text:

```
null
\vskip 1.3 cm
This text comes after 1.3 cm...
```

This text comes after 1.3 cm...
<table>
<thead>
<tr>
<th>Environment</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>array</td>
<td>Math arrays</td>
</tr>
<tr>
<td>center</td>
<td>Centered lines</td>
</tr>
<tr>
<td>description</td>
<td>Labelled lists</td>
</tr>
<tr>
<td>enumerate</td>
<td>Numbered lists</td>
</tr>
<tr>
<td>eqnarray</td>
<td>Sequence of aligned equations</td>
</tr>
<tr>
<td>equation</td>
<td>Displayed equation</td>
</tr>
<tr>
<td>figure</td>
<td>Floating figures</td>
</tr>
<tr>
<td>flushleft</td>
<td>Flushed left lines</td>
</tr>
<tr>
<td>flushright</td>
<td>Flushed right lines</td>
</tr>
<tr>
<td>itemize</td>
<td>Bulleted lists</td>
</tr>
<tr>
<td>letter</td>
<td>Letters</td>
</tr>
<tr>
<td>list</td>
<td>Generic list environment</td>
</tr>
<tr>
<td>minipage</td>
<td>Miniature page</td>
</tr>
<tr>
<td>picture</td>
<td>Picture with text, arrows, lines and circles</td>
</tr>
<tr>
<td>quotation</td>
<td>Indented environment with paragraph indentation</td>
</tr>
<tr>
<td>quote</td>
<td>Indented environment with no paragraph indentation</td>
</tr>
<tr>
<td>tabbing</td>
<td>Align text arbitrarily</td>
</tr>
<tr>
<td>table</td>
<td>Floating tables</td>
</tr>
<tr>
<td>tabular</td>
<td>Align text in columns</td>
</tr>
<tr>
<td>thebibliography</td>
<td>Bibliography or reference list</td>
</tr>
<tr>
<td>theorem</td>
<td>Theorems, lemmas, etc</td>
</tr>
<tr>
<td>titlepage</td>
<td>For hand crafted title pages</td>
</tr>
<tr>
<td>verbatim</td>
<td>Simulating typed input</td>
</tr>
<tr>
<td>verse</td>
<td>For poetry and other things</td>
</tr>
</tbody>
</table>

Table 6: Standard \LaTeX\ environments.
Finally, the command \vfill is used to add empty lines between two paragraphs so that the second paragraph goes exactly to the bottom of the page. For example,

\begin{tabular}{|l|}
| This appears at the top of the page\ldots \vfill \ldots and this at the bottom. |
\end{tabular}

5.3.3 Format/Paragraph Margins

Normally, the margins are set for the whole document as seen in Section 2.5. Redefining them for a section of text will not work: if you want to set a paragraph’s margins, you’ll have to create a new environment like in the following example:

\newenvironment{margins}[2]
{\begin{list}{}{\setlength{\leftmargin}{#1} \setlength{\rightmargin}{#2}} \item \end{list}}

Then you will use the new environment:

\begin{tabular}{|l|}
| As you can see, this paragraph has normal margins. \begin{margins}{0.5cm}{1cm} But please note that this paragraph has custom margins. \end{margins} |
\end{tabular}

5.3.4 Format/Paragraph Indentation

To set the amount of indentation of the first line of a paragraph, use the command \parindent. In the following example, we set a 1-cm indentation:

\begin{tabular}{|l|}
| \setlength{\parindent}{1cm} |
\end{tabular}

The commands \indent and \noindent allow/disallow indentation on the following paragraph. Finally, the distance between paragraphs is set by \parskip:

\begin{tabular}{|l|}
| \setlength{\parskip}{3pt} |
\end{tabular}

5.4 Format/Paragraph Border and Shade

To get framed (bordered) paragraphs or words, you have the choice of using the framed package or the \parbox command. The package calc is required in the latter case.
This is the simplest method, using framed:

\setlength{\FrameRule}{2pt}
\setlength{\FrameSep}{5pt}
\begin{framed}
  this is a framed paragraph!
\end{framed}
\definecolor{shadecolor}{rgb}{0.9,0.8,1}
\begin{shaded}
  this is a shaded paragraph, do you like it?
\end{shaded}

Equivalently, use the boxedminipage package and the equally named environment. For those who want to know more: the commands

\framebox{
  \begin{minipage}[c]{\linewidth}
    text to be framed
  \end{minipage}
}

are functionally equivalent to the boxedminipage environment.

This example uses \parbox:

\noindent
\fbox{
  \parbox{\linewidth}{
    \fboxsep -2 \fboxrule
    \fbox{again, a framed paragraph!}
  }
}
\linewidth sets the width of the minipage equal to that of the remaining text. Obviously, you can specify the width as you like.

Finally, to frame something adapting the frame to the width of the text:

\begin{framed}
  this is a word
\end{framed}

Modifying the parameter, you can adjust the frame width:

\begin{framed}[2\linewidth][r]
  this is another word
\end{framed}

Note that the second optional parameter specifies the alignment (to the right in this example).
5.5 Format/Colour

Now that you have a bordered paragraph, you’ll want to set its colour too. Do this:

```
\colorbox{yellow}{
  \begin{minipage}{0.8\linewidth}
    I am a minipage, my colour is yellow!
  \end{minipage}
}
```

I am a minipage, my colour is yellow!

More about colours in Section 5.2.4.

5.6 Format/Columns

The commands `\twocolumn` and `\onecolumn` start a new page and set the number of columns; they can also be used as parameters in `\documentclass`. If this is not enough for you, the package `multicol` provides an environment of the same name. I could have set this section in two columns with these commands:

```
\columnseprule=1pt
\begin{multicols}{2}[\subsection{entry{Format}{Columns}}]
  The commands `cmd{twocolumn} ... \\
\end{multicols}
```

The space between columns is controlled by the parameter `\columnsep`, and the thickness of the rule between columns by `\columnseprule`. The text given as optional parameter in brackets is excluded from the environment.

6 The Table Menu

Quite a complex subject... A table is a float (as explained in Section 4.12) that must fit on one page. It usually contains a `tabular` environment, even though other possibilities exist. By default, a table adjusts its width to match the width of its contents.

This is the general format of a table:

```
\begin{table}[htbp] % placement: here, top, bottom, separate page \\
% \begin{small} % sets the table font \\
% \begin{center} % optional \\
% 4-column table; alignment is left, centered, right, fixed width \\
\begin{tabular}{ll|c|p{4cm}|}
\hline % horizontal line \\
\textbf{Left} & \textbf{Centre} & \textbf{Right} & \textbf{4 cm} \\
\hline \\
row 1, col 1 & row 1, col 2 & row 1, col 3 & row 1, col 4 \\
\hline
row 2, col 1 & row 2, col 2 & row 2, col 3 & row 2, col 4 \\
\hline
\end{table}
```

Table 7: A sample table.

Sometimes, a table is too wide and won’t fit on the page. In that case, the rotating package provides the new environment `sidewaystable`. Also, rotating makes it possible to rotate the contents of a cell by a specified angle. Finally, the tabularx package lets one specify tables of fixed width: the \texttt{X} column specifier indicates that a column can be spread as needed.

Here’s an example:
The standard \texttt{tabular} environment cannot span more than one page. There are some packages that overcome this limitation: you will want to try out \texttt{longtable}, \texttt{supertabular}, and \texttt{xtab}.

To enable colours in tables, you use the \texttt{colortbl} package:

\begin{verbatim}
Colour by row:\\vskip 2mm
\begin{tabular}{|l|c|r|}
\rowcolor{cyan}
\hline
one & two & three\
\rowcolor{green}
\hline
one & two & three\
\rowcolor{yellow}
\hline
one & two & three\
\hline
\end{tabular}
\end{verbatim}

\begin{verbatim}
Colour by column:\\vskip 2mm
\begin{tabular}{|l|c|r|}
\hline
\rowcolor{cyan}|
\hline
one & two & three|\rowcolor{red}
\hline
\rowcolor{green}|
\hline
one & two & three|\rowcolor{yellow}
\hline
one & two & three|\rowcolor{cyan}
\hline
one & two & three
\end{tabular}
\end{verbatim}

6.1 Line Spacing

A line adjusts itself to the height of the text it contains. To add some space \textit{before} a line, the trick is to start it with a \texttt{\rule{0 length and specified height}}. To add space \textit{after} a line, use
6.2 Aligning Numbers

A special case of a tabular environment is when we want to align numbers with respect to the decimal positions.

The simplest method is using the `@` column specifier, which in practice is useful in tables containing only numbers. The column separator `&` is replaced by the decimal dot:

```
\begin{tabular}{r@{.}l}
  3.14159 \\
  1.61803 \\
  1.41421 \\
  100.00000
\end{tabular}
```

Alternatively, use the `dcolumn` package, which adds the `D` column specifier. `D` has three arguments: the separator to use in the \LaTeX{} source and in output (usually the same, `.\`), and the number of digits to the right of the decimal place indicator. Optionally, the third argument can specify the number of digits to the left and to the right of the decimal place indicator, separated by a dot. Lastly, if the third argument is -1, the material of the column is centered around the separator.

All material in the table is typeset in math mode. To insert headings, you’ll have to put the text in an `\mbox`.

```
\begin{tabular}{|D{.}{,}{4.2}|D{.}{.}{5}|D{.}{.}{-1}|}
\hline
\mbox{One} & \mbox{Two} & \mbox{Three} \\
10.33 & 10.33 & 10.33 \\
1000 & 1000 & 1000 \\
5.1 & 5.1 & 5.1 \\
3.14 & 3.14159 & 3.14159 \\
\hline
\end{tabular}
```

### 6.3 Using `slashbox`

This package adds the `\backslashbox` command:
6 THE TABLE MENU

6.4 Importing Data in \LaTeX{} Tables

For many people, data files are the bread and butter of everyday's work. Most data files are simply ASCII text with columns of numbers, but some people use spreadsheets. Nearly all spreadsheet applications can export sheets in the ASCII-based .csv file format; values are separated by the ';' character.

Converting a data file into a \LaTeX{} table is quite a tedious process. The following script for UNIX will convert a datafile with an arbitrary number of columns to a table. It will also work on .csv files.

```bash
#!/bin/sh
# dat2tex: converts tabular data to a tabular environment

if [ $# != 1 ]; then
  echo "Usage: $0 <datafile>"
  exit 1
fi

# is this a cvs file?
grep ";" $1 > /dev/null
if [ $? = 0 ]; then
  AWK="awk -F;"
else
  AWK=awk
fi

# ok awk, make my day
$AWK 'if (1 == FNR) {
    printf "\begin\{tabular\}\{l|l|l|\}\n"
    for (i = 1; i <= NF; i++) {printf "l"};
    printf "\}\n"}
  for (i = 1; i < NF; i++) {
    printf "$i" & "} printf $NF" \\\ \n"
  END {printf "\end\{tabular\}\n"} $1

# end of dat2tex
```
7 The Tools Menu

7.1 Tools/Mail Merges

This useful and time-saving tool is implemented in \LaTeX by the \texttt{textmerg} package. Let’s consider a simple document, in which the name, surname, and title of people we’re writing to may vary. The remaining text does not change.

We’ll define three fields, which are the variable part of the text: \texttt{Name}, \texttt{Surname}, and \texttt{Title}. Their values will be gathered from an external file, \texttt{data.dat}.

\begin{verbatim}
\documentclass{article}
\usepackage{textmerg}
\begin{document}
% let's declare the variable fields:
% \Void is for empty lines
\Fields{Name Surname Title-\Void}
\Merge{data.dat}{% 
  Dear \Title{} \Surname,\
  may I call you \Name?\
  Yours,\
  \hspace{3cm}Guido\clearpage}
\end{document}
\end{verbatim}

The fourth field, \texttt{\Void}, isn’t really necessary and it’s there for illustration. It’s preceded by a minus sign, which indicates that it can be empty in the data file. Simply put, we want to separate the records using empty lines.

The file \texttt{data.dat} reads:

Guido Gonzato
Dr.

Francesco Mulargia
Prof.

Carol
John-Paul II
Pope

That’s it: the resulting output will contain the merged text, one page for each recipient.

7.2 Tools/Labels

If making mail merges was easy, making labels is even trivial. Let’s suppose you want to make 20 equal labels on a 3\times8 peel-off label sheet. The package to use, predictably, is called \texttt{labels}.

In this example, we’ll make 10 plain labels and 10 boxed labels:
To make labels containing different addresses, you may use either an external file or insert the addresses in the main file:

\documentclass[a4paper,12pt]{article}
\usepackage{labels}
\LabelCols=3
\LabelRows=8
\LeftBorder=3mm
\RightBorder=3mm
\TopBorder=8mm
\BottomBorder=8mm
\LabelGridtrue
\begin{document}
\begin{labels}
1\(^{st}\) name
1\(^{st}\) address
1\(^{st}\) city, state, zipcode

2\(^{nd}\) name
2\(^{nd}\) address
2\(^{nd}\) city, state, zipcode

3\(^{rd}\) name
3\(^{rd}\) address
3\(^{rd}\) city, state, zipcode
\end{labels}
% or an external file containing exactly the same text:
% \labelfile{addresses.dat}
\end{document}
It is left to you to combine textmerg and labels!

7.3 Tools/Default Language

If you are not a native English speaker, you’ll want to use the package babel like in the following example:

\usepackage[italian,english]{babel}

In addition, to type accented letters and in general non-standard ASCII characters you may want to use the package isolatin1. However, this is not a recommended practice, because it reduces the legibility and portability of your file: you had better stick to the TeX way.

If you just can’t stand typing all those three- or four-letter clusters, then you could configure your editor to type those for you. For example, I set up my editor of choice (jed) to have it insert ‘é’ whenever I type ‘ê’. I included this in my .jedrc:

```
define latex_mode_hook ()
{
    set_abbrev_mode (1);
    if ( () = abbrev_table_p("LaTeX") )
        use_abbrev_table("LaTeX");
    #ifdef WIN32
        % prevent clash with movement keys
        undefinekey("â", "LaTeX-Mode");
        definekey("\'a", ""a", "LaTeX-Mode");
    #else
        local_setkey("\'a", "à");
    #endif
    local_setkey("\'e", "è");
    local_setkey("\'e", "é");
    local_setkey("\'i", "î");
    local_setkey("\'o", "ô");
    local_setkey("\'u", "û");
}
```

Please consult your editor’s documentation.

---

4 In computer jargon, ‘standard ASCII characters’ are the characters whose code is included between 32 (space) and 126 (tild).
7.4 Tools/Hyphenation

Although \LaTeX{} does a good job at hyphenating words, sometimes manual intervention may yield better results. Manual hyphens are specified inserting \textbackslash- where we want the word to be broken. A better way is to declare hyphenation rules:

\begin{verbatim}
\hyphenation{ge-o-phy-sics ge-o-lo-gy earth}
\end{verbatim}

The above declaration instructs \LaTeX{} not to hyphen the word ‘earth’. Another way to prevent a word to be hyphenated is to put it in \texttt{mbox}:

\begin{verbatim}
Do not hyphen \texttt{mbox{internationalisation}}, please.
\end{verbatim}

7.5 Tools/SPELL Check

\LaTeX{} is not aware of spell spelling. This task is done using external tools like \texttt{ispell}, \texttt{aspell} or others. Under \texttt{UNIX}, you can use \texttt{ispell} this way:

shell> \texttt{ispell -t mydocument.tex}

The \texttt{-t} switch instructs \texttt{ispell} to ignore \TeX and \LaTeX commands. If your language is not English, specify the appropriate dictionary with the \texttt{-d} switch:

shell> \texttt{ispell -d italiano -t mydocument.tex}

8 The Help Menu

There are many ways of getting help with \TeX, both online and offline. The best place to start is the CTAN site, \url{http://www.ctan.org/tex-archive/info/}.

- \texttt{info latex} (\texttt{UNIX} systems) gives a concise but very complete on-line summary of commands and concepts;
- \url{http://www.giss.nasa.gov/latex/} is a comprehensive on-line reference. Lots of useful links!
- \url{http://www.ctan.org/tex-archive/info/LatexHelpBook/} is a very nice help system for \TeX, fully integrated with Windows.
- don’t forget the \texttt{news:comp.text.latex} newsgroup: it’s an invaluable source of help.

Many GNU/Linux distributions ship with \TeX\TeX, one of the most complete \TeX/\LaTeX systems. A lot of documentation is provided, and is usually found in \texttt{TEXMF/doc}. Point your browser there, and be happy.
9 The End

This document is copyright © Guido Gonzato, 2001–2003, and released under the GNU General Public Licence. I really hope you’ll find this guide useful. For any suggestions or comments, please feel free to contact me.
A Document Templates

A template for the class \texttt{article} was presented in Section 2.1. More examples are shown in the following figures.

\begin{verbatim}
\documentclass[twoside,11pt]{book}
\begin{document}
\frontmatter
\begin{titlepage}
\title{The Book of Mine}
\end{titlepage}
\author{John B. Smith}
\maketitle
\tableofcontents
\mainmatter
\part{The Beginning}
\chapter{Introduction}
\section{Let’s Start}
The book starts here.
\part{The End}
\backmatter
Thank you for reading this book.
\end{document}
\end{verbatim}

Figure 3: Book template.
\documentclass[twoside,12pt]{report}
% tables and figures at the end:
\usepackage{endfloat}
\begin{document}
\title{Final Report}
\author{John B. Smith}
\date{London, \today}
\maketitle
\begin{abstract}
This is the final report.
\end{abstract}
\tableofcontents
\listoftables
\listoffigures
\part{Start}
\chapter{Begin}
\section{Introduction}
The report starts here.
\end{document}

Figure 4: Report template.

\documentclass[12pt]{letter}
\begin{document}
\address{My address}
\signature{Guido}
\begin{letter}{John's address}
\opening{Dear John,}
Thank you for being my friend.
\closing{Hope to see you soon,}
\ps{P.S. Say hello to granny!}
\encl{My son’s photographs!}
\end{letter}
\end{document}

Figure 5: Letter template.
\documentclass[a4paper]{article}
\usepackage{type1cm}
\usepackage{times}
\usepackage{color}
\usepackage{rotating}
\pagestyle{empty}
\begin{document}
\begin{sidewaysfigure}
\fontsize{2.5cm}{2.5cm}\selectfont
\centerline{\textcolor{blue}{\textbf{Please:}}}
\vskip 1cm
\fontsize{4cm}{3cm}\selectfont
\centerline{\textcolor{red}{DO NOT}}
\centerline{\textcolor{red}{SMOKE}}
\centerline{\textcolor{magenta}{HERE!}}
\vskip 1cm
\fontsize{2cm}{2cm}\selectfont
\centerline{\textcolor{magenta}{If you do,}}
\centerline{\textcolor{magenta}{you’ll be \textit{deboned!}}}
\end{sidewaysfigure}
\end{document}

Figure 6: How to write a notice.
\documentclass{article}
\usepackage[absolute,showboxes]{textpos}
\usepackage{color}
\usepackage{framed}
\usepackage{graphicx}
\setlength{\TPHorizModule}{10mm} % standard unit of length
\setlength{\TPVertModule}{\TPHorizModule}
\setlength{\TPboxrulesize}{1pt} % box line width
\% start everything near the top-left corner
\textblockorigin{0mm}{0mm}
\begin{document}
\setlength{\parindent}{0pt}
\definecolor{shadecolor}{rgb}{0.9,1,1}
\begin{textblock}{5}(0,0)
\% this block is 5 modules wide; height is
\% automatically determined
\begin{center}
\begin{minipage}[c]{0.8 \linewidth}
\begin{shaded}
This block is placed with its top left corner at the ‘origin’
on the page, which has been set to (0mm,0mm). The internal
margin and the shading are provided by the \texttt{minipage}
and \texttt{shaded} environments.
\end{shaded}
\end{minipage}
\end{center}
\end{textblock}
\begin{textblock}{6}(10,1)
This picture is at (10,1). Note that rotating it
by -90 makes it overflow the margin.
\end{textblock}
\begin{textblock}{5}[0.5,0.5](2.5,8)
This block is at position (2.5,8), but because the optional
argument [0.5,0.5] has been given, it is the centre of the block
which is located at that point, rather than the top-left corner.
\end{textblock}
\begin{textblock}{3,4}(6,4)
The dimensions of this block are 3\times4 cm.
Its origin is position (6,4) on the page. Note that the text
overflows the margin in some cases; you’ll want to
use the \texttt{minipage} environment to prevent that.
\end{textblock}
\end{document}

Figure 7: How to write a poster.